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Session Recap 

Session Topic: SAS® Visual Analytics Designer 
Session Date: 06OCT2014 
Recording:  
 

http://support.sas.com/training/us/lw/lwrecord.hsql?date=06Oct14&ccode=19884  

 

This session recap includes the Q&A from the session. Additional information and links to more detailed content 

are included. 

Don’t forget to register for additional Ask the Expert: SAS Visual Analytics sessions. 

 

 

 

 

 

 

 

 

 

Question: So what’s the difference between the Explorer and the Designer? Why are there two tools? 

Answer: The Explorer helps you learn about your data by visualizing it in different ways. The Designer 
enables you to present your findings in a report that you can view and interact with from 
several types of clients. 

Additional  
Information: 

Clients for viewing reports include the SAS Visual Analytics Viewer and the SAS Mobile BI app 
for iPad and Android tablets. You can also view your reports using other SAS applications 
such as SAS Enterprise Guide and the SAS Add-In for Microsoft Office. 

   
 User’s Guide: Overview of SAS 

Visual Analytics Explorer  

 User’s Guide: Overview of SAS 
Visual Analytics Designer 

 Exploration Basics 

 Report Basics 

 The Forest and the Trees: See it All 
with SAS Visual Analytics Explorer 

 Getting the Most Out of SAS Visual 
Analytics: Design Tips for Creating 
More Stunning Reports 

 Discussion: Explaining SAS Visual 
Analytics to Colleagues 

 

SAS Visual Analytics Toolkit 

▪ Product Overview 

▪ Getting Started Resources 

▪ Try the software yourself 

▪ Community 

▪ Free Video Tutorials 

▪ Documentation 

▪ Training 

http://support.sas.com/training/us/lw/lwrecord.hsql?date=06Oct14&ccode=19884
https://support.sas.com/edu/schedules.html?ctry=us&id=2243
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kco7sgodc9f7n1051ab8exs3kn.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kco7sgodc9f7n1051ab8exs3kn.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p00vwuyiokyq1qn1k7jk5gntrrpp.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p00vwuyiokyq1qn1k7jk5gntrrpp.htm
http://support.sas.com/training/tutorial/va64/va-explorer.html
http://support.sas.com/training/tutorial/va64/va-designer.html
http://support.sas.com/resources/papers/proceedings13/058-2013.pdf
http://support.sas.com/resources/papers/proceedings13/058-2013.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS120-2014.pdf
https://communities.sas.com/docs/DOC-4112
https://communities.sas.com/docs/DOC-4112
http://www.sas.com/en_us/software/business-intelligence/visual-analytics.html
http://support.sas.com/software/products/va/index.html
http://www.sas.com/software/visual-analytics/demos/all-demos.html
https://communities.sas.com/community/support-communities/sas-visual-analytics
http://support.sas.com/training/tutorial/#s1=2
http://support.sas.com/documentation/onlinedoc/va/index.html
http://support.sas.com/training/us/paths/bi.html#va
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Question: I am trying to determine the amount of first year sales for products that have been released in different 
months/years. I have the Product Introduction Date, Date of Sale, and Sales Amount available in my 
data. Is there a way in Visual Analytics to filter the sales/dates to include only 12 months after the first 
(minimum) Sales Date? 

Answer: An easy way of doing this is to create a new column (call it Date Difference) by subtracting the 
Release Date from the Date of Sale. However, you can’t just add date fields to an x-y 
expression. What you need to do is to use the TreatAs operator to have the LASR Server treat 
the Date field as Numeric. Then apply a filter to your table to keep only rows where your Date 
Difference is less than or equal to 365. 

 
Additional  
Information: 

 

   
 User’s Guide: Creating Calculated 

Data Items 

 User’s Guide: Numeric  (Advanced) 
Operators 

 User’s Guide: Date and Time 
Operators 

 Create Calculated Data Items  Discussion: Finding  number of days 
between to dates in SAS Visual 
Analytics 

 Discussion: Date & Week Numbers 
in SAS Visual Analytics 

 

Question: What are sparklines in a report table? How do they work? 

Answer: Sparklines are small line graphs that present 
a single line of data over time, shown on a 
list table. A sparkline is about the size of one 
or two words in the table and is great to 
understand trends in the data points by just 
looking at the corresponding fields and 
columns. It would be a great start for your 
further analysis after you see a trend 
occurring. To add a sparkline, position the 
cursor over your list table and right-click. On 
the menu, select Add sparkline. In the pop-
up panel provided, you need to select a time 
field and a measure to display. Also, you 
can type in a column heading and set a 
baseline value. 

 

 

Additional  
Information: 

 

   
 User’s Guide: Using Tables to 

Display Results 
 Create a List Table  Discussion: What is a table with 

sparklines 

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0i4r7imon277qn1fzfigcuzfxfa.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0i4r7imon277qn1fzfigcuzfxfa.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n048fxv35y1nczn19ho76ekkmx81.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n048fxv35y1nczn19ho76ekkmx81.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0hqjuvvuktsxrn17g12vrqk2rft.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0hqjuvvuktsxrn17g12vrqk2rft.htm
http://support.sas.com/training/tutorial/va64/data-items.html
https://communities.sas.com/thread/58920
https://communities.sas.com/thread/58920
https://communities.sas.com/thread/58920
https://communities.sas.com/thread/58922
https://communities.sas.com/thread/58922
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1615gve82xa0gn12zw1w609e4uh.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1615gve82xa0gn12zw1w609e4uh.htm
http://support.sas.com/training/tutorial/va64/list-table.html
https://communities.sas.com/thread/61307
https://communities.sas.com/thread/61307
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Question: When I use a List control, a Button Bar control, and a Drop-down List control, a frequency count is 
added to the panel beside each value. Can I remove this? 

Answer: The count appears because the Frequency measure is automatically added to the Frequency 
role for each of these controls. To remove the counts, you remove the Frequency measure 
from the Frequency role on the Roles tab on the right side of the Report Designer.  

Additional  
Information: 

 

   
 User’s Guide: Controls 

 User’s Guide: Using Controls to 
Display Results 

 Create a control report object  

 

Question: I’ve heard something about being able to set alerts in my reports. How do they work? 

Answer: SAS Visual Analytics can be configured to send a notification to specific users when report 
objects contain data that meets certain criteria. In addition to specifying the criteria for the 
alert, you can also specify how frequently the system checks to see whether alert criteria have 
been met, and how frequently a notification is sent to a user or group of users. 

Additional  
Information: 

 

   
 User’s Guide: Working with Alerts 

for Report Objects 

 User’s Guide: Subscribe and 
Unsubscribe to Alerts 

 Create an alert based on an 
expression 

 Discussion: Display Rules and Alerts 

 

Question: How can you get the report XML ? 

Answer: A Visual Analytics Designer 
report is stored in an XML 
format. There are a couple 
of ways that you can 
access the report XML from 
Visual Analytics Designer. 
Probably the easiest way 
would be to hold down the 
Ctrl key and press Alt and 
B while in the Designer 
window of the Viewer. 

  

Additional  
Information: 

 

   
   

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1w40gcbckxduzn1m5c55rfwtdso.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n148ej0xya6fr0n1wckjkmqgyilc.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n148ej0xya6fr0n1wckjkmqgyilc.htm
http://support.sas.com/training/tutorial/va64/control-report-obj.html
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p1tlzu3ahe0ad2n1khte3hq9il1n.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p1tlzu3ahe0ad2n1khte3hq9il1n.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0pp4occerqqgan1p4vljm8l3hye.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0pp4occerqqgan1p4vljm8l3hye.htm
http://support.sas.com/training/tutorial/va64/alert-expression.html
http://support.sas.com/training/tutorial/va64/alert-expression.html
https://communities.sas.com/thread/55927
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Question: In a crosstab, how can I show percent of ColumnTotal or RowTotal instead of TableTotal? 

Answer: There currently isn’t a way to create a Percent of Column Total or Percent of Row Total in a 
crosstab. On the Data tab, you can right-click a measure and select Create  Percent of 
Total to create a new column. You can add this to the crosstab, but it won’t be a Column or 
Row total field. 

Additional  
Information: 

 

   
 User’s Guide: Creating Derived Items  Create aggregated measures in 

Designer 

 

 

Question: Can I view my reports in Excel? 

Answer: If you have the SAS Add-In for Microsoft Excel, you can view your SAS Visual Analytics 
reports in Excel, Word, PowerPoint, and even Outlook.  

Additional  
Information: 

SAS Enterprise Guide also enables you to view your SAS Visual Analytics reports.  
 

   
 SAS Add-In for Microsoft Office 

Help: Working with Reports 

 SAS Enterprise Guide Help: Working 
with Results: Working with Reports 

 Integrating SAS Office Analytics with 
SAS Visual Analytics 

 Share Your SAS Visual Analytics 
Reports with SAS Office Analytics 

 Everyday Visual Analytics 

 

Question: I’ve got a report saved in the My Folder location. A colleague and I will both need to work on the report 
– how can I give him access to the My Folder location I use? 

Answer: Your My Folder location is created as a secure place that only you can access.  By design, 
you won’t be able to give your colleague to have access to your My Folder location.  Instead, 
move or copy the report to a SAS Folder that you can both access.  If there isn’t an already 
created folder that you can both access, contact your SAS administrator to request one. 

Additional  
Information: 

 

   
 System Administration Guide: 

Working with SAS Folders 

  SAS Visual Analytics: Managing 
User Permissions 

 

Question: What is involved in configuring Visual Analytics to work with SAS Enterprise Guide or the SAS Add-In for 
Microsoft Office? Is there any documentation that you could point to? 

Answer: Setting up your Visual Analytics reports to be viewable in SAS Enterprise Guide and SAS Add-
In for Microsoft Office is something that your Administrator will need to do. But briefly, in 
addition to SAS Visual Analytics, you must have some form of the SAS Business Intelligence 
Suite, including the SAS add-in, SAS Enterprise Guide, and SAS Management Console, 
licensed and installed in your system. Then your Administrator would set the connections and 
permissions up to enable Enterprise Guide and Microsoft products (Word, Excel, PowerPoint) 
to access the reports. 

Additional  
Information: 

 

   
   Integrating SAS Office Analytics with 

SAS Visual Analytics 
 Share Your SAS Visual Analytics 

Reports with SAS Office Analytics 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1ticv66yqm3ecn1696rpdyarqev.htm
http://support.sas.com/training/tutorial/va64/aggregated-measures.html
http://support.sas.com/training/tutorial/va64/aggregated-measures.html
http://support.sas.com/documentation/onlinedoc/addin/index.html
http://support.sas.com/documentation/onlinedoc/addin/index.html
http://support.sas.com/documentation/onlinedoc/guide/index.html
http://support.sas.com/documentation/onlinedoc/guide/index.html
https://support.sas.com/edu/schedules.html?ctry=us&id=1825
https://support.sas.com/edu/schedules.html?ctry=us&id=1825
http://support.sas.com/resources/papers/proceedings14/SAS274-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS274-2014.pdf
http://blogs.sas.com/content/sascom/2014/03/07/everyday-visual-analytics/
http://support.sas.com/documentation/cdl/en/bisag/67481/HTML/default/viewer.htm#p1az7wj1xkvyqyn16526p7exxhyx.htm
http://support.sas.com/documentation/cdl/en/bisag/67481/HTML/default/viewer.htm#p1az7wj1xkvyqyn16526p7exxhyx.htm
http://blogs.sas.com/content/sgf/2014/05/21/sas-visual-analytics-managing-user-permissions/
http://blogs.sas.com/content/sgf/2014/05/21/sas-visual-analytics-managing-user-permissions/
https://support.sas.com/edu/schedules.html?ctry=us&id=1825
https://support.sas.com/edu/schedules.html?ctry=us&id=1825
http://support.sas.com/resources/papers/proceedings14/SAS274-2014.pdf
http://support.sas.com/resources/papers/proceedings14/SAS274-2014.pdf
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Question: I’ve got a report already created for my product sales data and it’s working great. Now I’ve got to 
create almost the same report but using supplier cost data. Is there any way I can reuse my existing 
report with this different data table? 

Answer: There are several ways to reuse the existing report: 

 You can make a copy of the first report and then change the data source to the supplier 
cost data.  You would change the data source by using the Change Data Source selection 
from the Options menu on the Data tab. Data items that are not in the new data source will 
be removed from any report objects, so this method works best if the data items have the 
same name in the new table.  

 You can import report objects from the original report into a new report that uses the new 
data source.  That way you can select just some of report objects from the original report 
and not have to use them all.  You’ll still have to fix any imported report object that uses a 
data item that is not in the new data source. 

Additional  
Information: 

 

   
 User’s Guide: Working with Data 

Sources in Reports 

 User’ Guide: Base a New Report on 
Report Objects Imported from One 
or More Existing Reports 

 Create a Multi-Section Report and 
Import Report Objects 

 

 

Question: I want to filter all of my report objects the same way, including those in another section. What's the 
best way to do this? 

Answer: The easiest way to apply a filter to an entire report is to use the Data Source filter. This filter 
can be found in a different place than usual. Typically, the user will apply filters on the right 
side of the Designer window in the Filters tab. But the Data Source filter can be found in the 
Data tab on the left side of the window. Select the Options button and then New Data Source 
Filter. This enables you to define an expression to set up a filter on any of your data sources 
using data items, column templates, and operators. 

Additional  
Information: 

An added benefit of using a Data Source filter is that the Data Source filter updates the 
cardinality values that appear on the Data tab. 

   
 User’s Guide: Working with Data 

Source Filters in a Report 

 User’s Guide: About Report Filters 

 Report Basics  

 

Question: The report is constantly updating when building a report, which means that every time I make a change 
to the report, the view can be slightly or significantly different. Can I build a report without having it 
update constantly? 

Answer: There is an auto-update feature in Visual Analytics that is set. To change this, use the Auto-
Update check box at the top right side of the Workspace. Uncheck that and you should be able 
to make changes and not have the objects change until you want them to.  

Additional  
Information: 

 

   
 User’s Guide: Control Data 

Visualization Data Updates 

  

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p1wu8wfn7fpirfn1gsmmivteaku8.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p1wu8wfn7fpirfn1gsmmivteaku8.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kywim3e9s2w6n1rvozq5cj8yy5.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kywim3e9s2w6n1rvozq5cj8yy5.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p0kywim3e9s2w6n1rvozq5cj8yy5.htm
http://support.sas.com/training/tutorial/va64/multsection-report.html
http://support.sas.com/training/tutorial/va64/multsection-report.html
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p146ddbi2wcokkn1ca3v8s5jfxpt.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p146ddbi2wcokkn1ca3v8s5jfxpt.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p06et8z817thcvn1mm32zkdj8emv.htm
http://support.sas.com/training/tutorial/va64/va-designer.html
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n184uwnxe56qzfn18xxkvah3wks6.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n184uwnxe56qzfn18xxkvah3wks6.htm
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Question: I have a pie chart, bar chart, and treemap that all show the same values such as country. How can I 
make the countries the same color in all of the graphs and have it automatically apply to new graphs in 
the same report? 

Answer: You can accomplish this by creating a report-level display rule. Click the Display Rules tab in 
the Right pane, select the report from the drop-down list at the top of the tab, and click New to 
create a new display rule. Add each country value to the rule and set the desired color. 

Additional  
Information: 

    

   
 User’s Guide: Add Report-Level 

Display Rules 

 User’s Guide: Overview of Display 
Rules 

 Create Display Rules  Usage Note: Support for display 
rules on specific report objects in 
SAS Visual Analytics Designer 

 

Question: Printing is listed as "pre-production." What does that mean? 

Answer: Printing in the Designer has not been fully implemented in the 6.4 release. Pre-production 
features provide limited functionality that might change in a future release. 

Additional  
Information: 

 

   
 User’s Guide: Print a Report   

 

Question: Where do I find documentation of keyboard shortcuts such as holding down the Ctrl key and then 
pressing Alt+B? 

Answer: The keyboard shortcuts are not currently documented.  These shortcuts are typically used for 
troubleshooting and should be used only at the direction of SAS Technical Support. 

Additional  
Information: 

 

   
   

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n13l9eants3nutn1x03v10i8fq9i.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n13l9eants3nutn1x03v10i8fq9i.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0nn6y8y10tgven1vmgq4xf9y2w4.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0nn6y8y10tgven1vmgq4xf9y2w4.htm
http://support.sas.com/training/tutorial/va64/display-rules.html
http://support.sas.com/kb/49/684.html
http://support.sas.com/kb/49/684.html
http://support.sas.com/kb/49/684.html
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n1qkyn8h6kcyvun1jv3llwu4uwzk.htm
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Question: Why would I want to use the full-screen report view instead of the tablet report view? 

Answer: Designing a report in Visual Analytics Designer should be done with the end user in mind.  
These different views will alter the canvas to dimensions that are intended for consumption on 
the web using Visual Analytics Viewer (full screen) or using a tablet device (tablet or wide- 
screen tablet).  If most of your users will be consuming the reports via Visual Analytics Viewer, 
consider using the full-screen layout.  If most of your users will be consuming the reports via a 
tablet device, consider using one of the tablet layouts. 

Additional  
Information: 

You can change the report view for the current report by 
selecting Report View from the View menu or by using 
the Aspect ratio button in the upper right corner of the 
report workspace. 

 
 
You can also use the Preferences window to set the report view that you want to use as the 
default for new reports. 

   
 User’s Guide: Choose a Report View 

 User’s Guide: Specifying Your 
Preferences for the Designer 

  

 

Question: Can you describe how comments work? 

Answer: Sure, comments are a great way to add information to a report as well as to collaborate with 
your colleagues. You can add and interact with report comments in the Designer and from the 
Object Inspector on the Home page. When using the SAS Visual Analytics Viewer or the 
Mobile BI app, you can create, view, and interact with report comments, and you can also 
create, view, and interact with report object comments. You can add new comments, reply to 
existing comments, and even attach files to your comments. Report object comments cannot 
be added, changed, or viewed using the Designer or the Object Inspector on the Home page. 

Additional  
Information: 

You can define an administrator for the comment facility.  The administrator will be able to 
delete comments and attachments.  

   
 User’s Guide: Add Comments to a 

Report 

 User’s Guide: Add Comments to 
Objects on the Home Page 

 User’s Guide: Add Comments to a 
Report in the Viewer 

 Export the Data Used in Report 
Objects and Collaborate Using 
Comments 

 Get Started with the SAS Visual 
Analytics Home Page 

 Discussion: SAS Visual Analytics and 
comments limitations 

 

Question: Is there any way to set default values in the controls, such as the range slider? 

Answer: There is currently no way to define a default value for these objects.  However, if you create a 
report with a particular value for these objects, this will be remembered when the report is 
opened for editing. 

Additional  
Information: 

 

   
   

 

http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n08btnbf8t7xygn1p0n9pazti6mr.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n00v0dljlj5fxan1t560lnob2c9z.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n00v0dljlj5fxan1t560lnob2c9z.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0fdzgowsb5e7un1i8422i0arvo5.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n0fdzgowsb5e7un1i8422i0arvo5.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p12j35wvnfsclin1gknrwoze3uth.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#p12j35wvnfsclin1gknrwoze3uth.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n15afm8xlo5spkn1hwqp6c2ty423.htm
http://support.sas.com/documentation/cdl/en/vaug/67270/HTML/default/viewer.htm#n15afm8xlo5spkn1hwqp6c2ty423.htm
http://support.sas.com/training/tutorial/va64/export-report-obj-data.html
http://support.sas.com/training/tutorial/va64/export-report-obj-data.html
http://support.sas.com/training/tutorial/va64/export-report-obj-data.html
http://support.sas.com/training/tutorial/va64/va-homepage.html
http://support.sas.com/training/tutorial/va64/va-homepage.html
https://communities.sas.com/thread/56471
https://communities.sas.com/thread/56471
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Question: I see description and keyword fields when I look at the report on the Home page, but it always says 
"(not available)". How can I set these values? 

Answer: When you save a report, you 
select the SAS Folders 
location and enter a report 
name. You can add a 
description and keywords by 
selecting File  Report 
Properties in the Designer. 

  

Additional  
Information: 

You can also customize the Open window to show additional fields such as Description and 
Keywords.  Right-click the column headings on the right side of the Open window and select 
Customize. Choose the fields that you want to display and click OK. 

 

   
 User’s Guide: View Report 

Properties 

  

 

Question: Is there a way to create specialized graphs for use in the reports? 

Answer: Yes.  You can use the custom graph interface to create custom graphs.  This is available by 
clicking the down button beside the Home page icon and selecting Build Custom Graph. 

Additional  
Information: 

 

   
 User’s Guide: About the Graph 

Builder 
 Create a Custom Graph with the 

Graph Builder 

 

 

Question: What are hierarchies and why would you use them? 

Answer: Hierarchies are an arrangement of related objects into levels that are based on parent-child 
relationships.  For example, a geographic hierarchy might be defined as Country > Region > 
State.  Hierarchies can be defined in a Crosstab object.  Hierarchies are useful in that they 
enable the dynamic navigation of data by expanding or drilling into certain areas of your data. 

Additional  
Information: 

 

   
 User’s Guide: Working with 

Hierarchies in a Report 

 User’s Guide: Derive a Hierarchy 
from a Date, Time, or Datetime Data 
Item 

 Create and Manage Hierarchies  
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Question: Can you show how to link between sections of a report? 

Answer: You can define links by right-clicking a report object and specifying Add Link.  You can 
specify to link to a different report, a different section in the same report (provided there are 
multiple sections), or to an external link. 

Additional  
Information: 

If linking to another object, Visual Analytics will pass a parameter based on the cell or 
graphical item that you click to the child section.  This parameter will act as a filter for the child 
section, provided the data contains the same data item. 

   
 User’s Guide: Overview of Linking 

 User’s Guide: Creating Links 

 Use Interactions and Links in a 
Report 

 Discussion: Report Link with 
Parameter 

 Discussion: Linking between 
Sections without Filters 

 

If you have any questions, please contact: 

SAS Education Customer Service 

1-800-333-7660 

training@sas.com  
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